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In June 2019, we will release the next major 
version of Orchard® Harvest™ and Orchard® 

Pathology, version 12. The current version—11 
—was originally released in October 2016 and 
has undergone 10 in-version update releases 
since. Beginning last year, Orchard Software’s  
Development department has been preparing 
for the upcoming version update that includes 
an underlying database platform upgrade. 

A New Facelift
	 The most noticeable changes to Harvest and 
Orchard Pathology are newly updated graphics. 
Last summer, we released new company and 
product logos in conjunction with our 25th  
anniversary. So, in v12, we updated logos, 
icons, and other visual elements to bring the 
graphical presentation of our products in line 
with the Orchard brand.  
 
	 The Sign In window has a new, fresh look 
and the Work Centers icons have new graphics 
that depict the purpose of the shortcut.

	 Other updates include the icons on the Find a Patient/Sample/
Case window, icons on the Patient List window, and icons within the 
patient record window.

The Work Centers 
icons in version 11.

The Work Centers  
icons in version 12.
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V12 Preview 
Continued from page 1.

QC Comments Section Allows for Easily 
Identifiable Supervisory Review
	 We added functionality to the Review Quality Control 
window to further organize and document supervisory 
review of quality control files.  

	 Previously, the Review Quality Control window provided 
a single Comments text field that allowed users to add 
comments to the quality control file. This method provided 
no way to “lock” a comment, and any user with access to 
this window could alter previously entered comments.  

The Review Quality  
Control window  
in version 12.

The Review Quality  
Control window  
in version 11.

In v12, the Review Quality Control window looks a bit 
different. All previously entered comments appear in a 
read-only display field that prevents users from editing 
a previously saved comment. You may use the separate 
New Comment field to append a new comment to any 
previously entered comments. Additionally, you can add 
an ACO to automatically prepend the date, time, and CLIA 
ID to any new comments entered. Taken together, these 
features allow laboratories to track supervisory reviews in 
the form of date/time/user stamped comments.
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Batch options in version 11.

Orchard Pathology Undergoes  
Significant UI Update 
	 Also included in the v12 release is an updated 
and refreshed user interface for the electronic 
worksheet in Orchard Pathology. If you have 
not already signed up to attend Orchard’s 
symposium in June, there is still time to sign up 
and come see the new anatomic pathology 
worksheet in action in the See What’s New in  
Orchard Pathology breakout session. At our 
annual User Group & Symposium, you can 
learn all about the newest features in all  
our laboratory information systems. Visit  
www.orchardsoft.com/symposiums today  
to sign up.

	 If you are interested in upgrading to Orchard’s 
newest release of Harvest or Orchard Pathology, 
contact Orchard Technical Support today at 
(800) 571-5835. 

Batch options in version 12.

V12 Boasts New Time Savers in Work in Progress
	 We added anatomic pathology (AP) features to Work in Progress (WIP) to assist with the batch manipulation of records. 
Prior to this release, the only batch micro/AP features available in WIP were the options to batch result and batch report 
multiple specimens at once. In Harvest and Orchard Pathology v12, we added batch micro/AP options in the AP Batch 
Selection window, including the ability to batch print the AP worksheet with or without details, batch print a patient’s 
previous AP history, and batch print a patient’s previous AP reports. 
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Hotkeys Help Move Quickly & Conveniently Through  
Orchard Pathology, Harvest, Copia, Trellis, & Sequoia

For more than 15 years, since the release of Orchard® Harvest™  
v5 in 2003, Orchard Software’s products have contained hotkeys 

designed to help you perform common tasks more efficiently. The 
phrase “hotkeys” is a technology term for keyboard combinations 
that act as shortcuts to open specific windows or perform certain 
functions. In more recent years, Orchard has expanded the development 
of hotkey shortcuts to other products, including Orchard® Pathology, 
Orchard® Copia®, Orchard® Trellis™, and Orchard® Sequoia™.

Orchard Pathology & Harvest Hotkeys
	 In Orchard Pathology and Harvest, there are approximately 250 
different hotkey combinations available throughout all modules of 
the application.

	 Some of the more common hotkeys that are universally used in a 
variety of windows:
	 • Ctrl+, – Opens the Release Stored Orders (RSO) window.
	 • Alt+E – Opens the Edit menu.
	 • F5 – Refreshes the current window (where available).
	 • Ctrl+W – Closes the active window.
	 • �Ctrl+Q – Exits the Harvest or Orchard Pathology  

application.
	 • Ctrl+P – Opens the print dialog box.
	 • �Ctrl+F – Opens the Search and/or Find Patient/Sample/Case window.  

	 A couple newer hotkey functions:
	 • ��Simultaneously pressing the Ctrl and down arrow key in the 

Batch Order Entry window allows you to cycle �through up to
         10 of the most recent orders made since the window was opened.

	 • �Holding the Ctrl key while using the left/right 
arrow keys allows you to navigate through 
tabs in the Editing Patient, Work in Progress, 
Review Results, Reference Labs, Deliver 
Finished Results, Send to Host, Preferences, Fax 
Queue, Manage HL7 Files, Patient List, Order 
Patient Samples, Advanced Configuration 
Options, and Find Patient or Sample/Case 
windows.

Copia, Trellis, & Sequoia Hotkeys
	    Copia, Trellis, and Sequoia also provide a 
variety of hotkeys. Given that Copia, Trellis, and 
Sequoia are browser-based applications, hotkeys 
specific to an Internet browser, such as Alt+F to 
open the File menu and F5 to refresh, also work 
in conjunction with Orchard-specific hotkeys. 
 
	 Some common Copia, Trellis, and Sequoia 
hotkeys:
	 • �Alt+F1 – Toggles the navigation menu between  

visible and hidden status.
	 • �Alt+C – Cancels the current action or engages 

the Back button in AdminCenter menus.
	 • �Alt+S – Selects buttons labeled Save, OK, or 

Select (if available on the current page).
	 • �Alt+P – Moves the cursor from its current 

position to the Find Patient field at the top 
of the page.

	 • Alt+Q – Signs you out of the program.
	 • Alt+? – Opens online help in the Product Center. 
 
	 At Orchard, we develop our applications with 
the knowledge that your laboratory is busy and 
your time is valuable. It is our goal to provide you 
with the tools you need to speed your workflow 
and increase your productivity. If you would like 
to review the complete list of hotkeys available 
in each application, sign in to Orchard Resource 
Central from our website, www.orchardsoft.com, 
open the Product Center, and search for “hotkey” 
and your product name. 
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Orchard Products Boast Many Useful Time-saving Features

See “Time-saving Features”  
on page 6.

A 2017 Select Science article states that there are three 
variables that dictate the level of efficiency in a life 

science laboratory. First, the people working in the lab; 
second, the processes they follow; and third, the equipment 
they have and how they use it. We are committed to giving 
you the very best tools for your laboratory. We know 
that your LIS is not just “equipment,” but is a useful tool 
that can help you get the most out of your laboratory’s 
business. We do not want to just be your LIS vendor; we 
want to be your partner. Therefore, we also want to help 
you use your LIS solutions to their ultimate potential. 

	 For more than 25 years, we have been developing our 
laboratory solutions with you and your laboratory in mind. 
We know how important efficiency is to the success of 
your laboratory, so we would like to provide you with a 
synopsis of some essential time savers that your Orchard 
laboratory information systems can provide for you.

Scratchpad Copies Large Amounts  
of Information Quickly
	 Beginning in version 11.161222 of Orchard® Harvest™ 
and Orchard® Pathology, a scratchpad feature is available 
that allows you to easily create, copy, print, and paste 
text notes while using the programs. This feature is 
available as a right-click contextual menu option you can 
enhance with Advanced Configuration Options (ACOs). 

All right-click contextual menus in the program that contain 
“Copy to clipboard” and “Display text” options also  
contain the “Copy to scratchpad” option. 
 
	 To manually add information to the scratchpad, right-click 
on fields in Harvest or Orchard Pathology that allow  
copying and select the “Copy to scratchpad” menu option.  
You can also highlight multiple rows and copy an entire 
column of information to the scratchpad. Visit the Product  
Center on Orchard Resource Central and search for 
“scratchpad” to view the Expanded Release Note for 
more information on how to use the scratchpad. 

Use the scratchpad to create, copy, print, 
and paste text notes.

Bulk Change Increases Efficiency During 
Setup & Maintenance
	 Another useful time saver in Harvest and Orchard  
Pathology is the ability to bulk change table fields. Over 
the years, based on your feedback, we have continued 
to add more bulk change functionality throughout our 
applications. Now, there is an extensive list of fields 
eligible for bulk changes. For example, in the above 
screenshot, there are 18 different fields in the Order 
Choices table you can bulk edit. Try it out in your system 
and see how you can quickly and efficiently update your 
data tables.  

Bulk edit options on the Order  
Choices table.
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Time-saving Features 
Continued from page 5.

Streamlining the Use of Text Shortcuts
	 Text shortcuts are additional time-saving features 
that have been available in Harvest and Orchard  
Pathology for many years. We would like to point 
out additional functionality you can use with your 
text shortcuts to make using them even easier. 

	 As a refresher, text shortcuts are user-defined  
comments you can use by pressing a combination  
of keys, causing the system to expand those  
characters into longer text. This greatly reduces  
the amount of time needed to enter patient alerts, 
add comments, or record observations. Once  
configured, text shortcuts are invaluable tools  
for your LIS users. 

	 To help with training, and as a useful refresher, 
there is a shortcut to access your shortcuts. Yes,  
you read that correctly! You can display a list of text  
shortcuts by typing “/help” (no quotes) into any field 
that supports text shortcuts. This prompts Harvest  
and Orchard Pathology to list all active text shortcuts 
in the Shortcut Dictionary window with up to 50  
characters of the expanded text for each. Enter  
text in the Search field to narrow the items in the 
Shortcut Text column (note that Harvest and  
Orchard Pathology search the last column clicked  
or sorted). After searching, click the Show All button 
to again display all shortcuts in the list. To insert a  
text shortcut, you can either double-click the desired 
entry or highlight a shortcut and click the Insert button. 

Note that you can apply an ACO to use a  
different shortcut if “/help” does not suit 
your needs. For example, if you add this ACO: 

[Shortcuts]
Dictionary=/? 

And type “/help,” nothing will happen. But 
if you type “/?”, the Shortcut Dictionary  
window displays. 

Custom Navigation Menus Allow for Role-specific 
User Menus
	 Perhaps the most useful customization feature in Orchard’s 
products is the ability to create custom user-, location-, and/or 
practice-specific navigation menus.

	 In Harvest and Orchard Pathology, there are more than 25 
different shortcuts that may be applied to the user-specific Work 
Centers toolbar. You can change your Work Centers toolbar by 
selecting My Work Centers from the File menu. Here, you can 

Type /help into any window that supports text shortcuts to open the Shortcut  
Dictionary window.

The Shortcut Dictionary window displays all active shortcuts.
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Join Us at AACC 2019: See Trellis & Sequoia at the Show

Each year, laboratory scientists from across the globe travel to attend the world’s largest laboratory industry event, 
the American Association for Clinical Chemistry’s (AACC) Annual Scientific Meeting & Clinical Lab Expo. Packed with 

nearly 300 educational sessions and the opportunity to experience first-hand the introduction of more than 200 new 
industry products, attendees from various disciplines network with peers while learning the latest trends taking place in 
laboratory medicine. 

	 This August, Orchard Software is proud to head west to Anaheim, California, to share its POCT data management 
and integration solution, Orchard® Trellis™, and its enterprise-class LIS, Orchard® Sequoia™. If you’re heading to AACC, 
make sure to stop by our booth, #1351, to see our newest laboratory solutions. We’re excited to share what we’ve 
been growing!  

view all available shortcuts, as well as 
add, remove, and rearrange shortcuts 
in your own Work Centers toolbar. One 
newer feature on the Work Centers  
Preferences window is the ability to  
copy preferences from one user to  
another. This saves time in setting up 
new employees in the system. 

	 Similarly, in Orchard® Copia®, Orchard® 
Trellis™, and Orchard® Sequoia™, system 
administrators can create custom  
navigation menus for their practices 
or locations to provide faster links to 
frequently used menu items. These links 
display in the side toolbar with the user’s 
information and allow quick access to 
pages within Copia, Trellis, or Sequoia  
or to external locations.

	 Note that if you have configured both 
system default and location-specific  
custom navigation, the signed-in  
location’s settings will take precedence. 
Take it for a spin in your Copia, Trellis or 
Sequoia system and see what you think!

	 For more information on these and 
other time-saving shortcuts within 
Orchard’s applications, search for the 
features in the Product Center on  
Orchard Resource Central. 

Type /help into any window that supports text shortcuts to open the Shortcut  
Dictionary window.

Copy Work Centers preferences from one user to another.

Create custom navigation menus in Copia, Trellis, and Sequoia.
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All About Orchard Technical Support

Orchard Software’s Technical Support team is consistently 
excelling at customer service amidst tremendous growth. 

Technical Support is the largest portion of the Operations 
department, with more than 35 associates in varying levels 
of front-facing client support. This group of talent is the 
face of Orchard. 

Orchard’s Technical Support Team  
	 When customers call Technical Support, they enter a queue. 
Our Technical Support team springs to action to serve customers  
in the order they call in, and it does its best to keep the 
wait time down. 

	 When a client calls or emails Technical Support, a Technical  
Support Receptionist fields the request, performing the “triage” 
by answering, dispatching, and routing the inbound calls.
 
Then, the team has three tiers of front-line support to 
facilitate an escalation system for trouble issues:
	 • �Tier 1: Provides front-line support to Orchard clients via 

phone and email.
	 • �Tier 2: Provides escalated support for Tier I and our 

system installers on the Field Implementation team.
	 • �Tier 3: Provides escalated support for the entire Operations 

department; performs optimization maintenance on 
databases; creates custom SQL queries and 4D commands; 
and travels on-site as needed.

 
	 Beyond these three levels of front-line support, Orchard 
has Technical Support Team Leads who are available for 
issue escalation and to serve as liaisons between direct client 
support, account management, and product development. 
Team Leads report to the Call Center Manager, who, along 
with the Assistant Call Center Manager, is responsible for 
high-level issue escalation, as well as long-term strategic 
planning, ongoing policy development, documentation, and 
functional components of the Technical Support team.

The Orchard Software Technical Support team celebrates Support Appreciation Week in March 2019.

Contact Technical Support by Phone, Email, or Web 
	 Throughout our 25-plus years, we have made listening 
to our customers a major part of our company culture. So, 
when customers requested improvements to the accessibility 
of our Technical Support services, we answered. You now 
have several options to contact Orchard Technical Support: 
	 1. �Call Center: Contact our call center 24 hours a day, 

seven days a week at (800) 571- 5835. This is best for 
emergency and urgent issues; however, please feel 
free to call with any issue.

	 2. �Email Technical Support: Email us at  
support@orchardsoft.com. We recommend this 
method for submitting non-emergency support  
issues, scheduling a Technical Support phone call,  
or sending screenshots of error messages. 

	 3. �Submit a Form: Access our Contact Technical Support 
form on our website at www.orchardsoft.com/ 
contact-technical-support-form.html. Contact us  
this way to submit non-emergency support issues, 
schedule a system upgrade, request account information, 
and obtain technical specifications and hardware  
requirements for all Orchard products. 

 
	 Remember that you can also view your Technical Support 
history at any time by signing in to our website. Once 
signed in, you may review previously closed and currently 
open support tickets. 

Speed Up Your Technical Support Calls 
	 Here are some steps you can take to help us resolve 
your problem more efficiently when you do find it necessary 
to call our Technical Support team:
	 • �Designate Staff for Calls: Be selective about whom 

you designate to contact and work with Orchard’s 
Technical Support team. It is preferable to have only 
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your local system administrator(s) call regarding system 
problems because they will be able to access the entire 
application for repairs.

	 • �Record Error Messages: Record the exact wording  
of any error messages you received, as well as the 
details of the problem, including the frequency  
of the problem and any actions taken immediately 
before the problem occurred. 

	 • �Note Your Version: Record the version/build number 
that you are calling about. 

	 • �Know Your Account Number: Have your account 
number available. This will help our staff as they  
create your support ticket.

	 • �Set Aside Time: Be prepared to work with the Orchard 
Technical Support Specialist on your problem. It is  
important that you and the Technical Support Specialist 
form a partnership. We rely on you to be our eyes and 
ears as we work together to troubleshoot the problem 
and find a solution. 

	 • �Have Network Admin On-hand: If you suspect that 
your network is related to the problem, be sure to 
have your network administrator available for the 
support call.

	 • �Get Your Phone Ready: Make sure your phone is 
near your computer when you call. This will make it 
easier to answer questions about your system and the 
problem you are having. This also enables you to try 
solutions proposed by the Orchard Technical Support 
Specialist.

	 • �Use a Handset or Headset: If you are using a  
speakerphone, consider switching to a handset or 
headset. We have had experience with speakerphones 
cutting off unexpectedly or picking up a lot of external 
noise, making communication difficult. 

	 • �Record Your Ticket Number: If it is a new problem and 
you are given a ticket number, please write that number 
down so you can refer to it in future conversations. 
This helps us log problems and track them through to 
completion.

	 • �Provide a Ticket Number (if you have one): Let us 
know up front if your problem is an existing issue. If 
you were given a tracking or ticket number in a previous 
call, please give us that number.

 
	 • �Describe Your Issue: Your description of the issue  

will help the Orchard Technical Support Specialist  
determine the correct troubleshooting steps. If you can 
reproduce the problem, describe each step in the order 
that generates the problem.

	 • �Describe Recent Changes: Note and describe any  
recent changes you have made to your system, network, 
or instrumentation. No matter how insignificant a 
change may seem, it is important to know about it to 
ascertain what effects it may have had on your system. 
Think back to when the system was working properly, 
and then to when you first noticed the problem. Note 
any changes made around that transition.

	 • �Prepare to Troubleshoot: Be prepared to troubleshoot 
the problem. The Orchard Technical Support Specialist 
may ask you to perform some tasks to get a better picture 
of what is happening or take some steps toward fixing 
the problem. If you have already performed some of 
the steps, make sure to tell the Technical Support Specialist 
about the outcome of those steps. It may still be necessary 
to repeat some of the steps with us. 

	 • �Ask Questions: Make sure to ask questions if you do 
not understand something the Orchard Technical Support 
Specialist asks you to do. We want to make certain you 
are confident using your Orchard system. We will be 
glad to answer any questions you have about the problem 
you were having or the solution to your problem. 

Technical Support Feedback Process
	 On October 1, 2018, we began utilizing a new Technical 
Support feedback process, where we email customers 
questions related to their experiences with the Technical 
Support team. Each time an Orchard Technical Support 
Specialist closes a ticket for a client, that client receives an 
email containing a link to a survey. 

See “About Orchard Technical Support”  
on page 10.
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Orchy®* was last seen at the Sultan Ahmed Mosque  
in Istanbul. Blue hand-painted tiles adorned the  

interior walls, which is why it is also called the Blue 
Mosque. Orchy was amazed and taken in by all the  
glorious colors and smells coming from the market.

Congratulations, Dorinda! 
	 Dorinda J. Fiore is the Laboratory Manager at Associates  
for Women’s Medicine in North Syracuse, New York. She 
guessed Orchy’s location and is the Orchy prize package  
winner.

Wicked Good Time
	 Recently, Orchy was seen in a historic city where the 
police still Make Way for Ducklings. Orchy stopped and  
raised a toast “Where everybody knows your name.” Later that afternoon, he stopped for a spot of tea, then walked a famous 
trail through the old city, feeling free. When he came to the harbor, he was speechless: There in front of him, launched in 
1797, made of oak, winner of 33 battles, was the symbol of this country’s fighting spirit. Orchy got apple chills! He thought,  
“Come by land or by sea, this is something to see!”

	 If you think you know where Orchy is, please send your answer to  
news@orchardsoft.com by June 24, 2019, to be eligible to win an  
Orchard prize package. 

* �Orchy is a trademark of Orchard Software Corporation for installation of laboratory software and technical  
support services, namely, troubleshooting of computer software problems; maintenance of computer software.

Want to keep up with Orchy’s travels? 
Visit our Company Culture webpage at  
https://www.orchardsoft.com/company- 

culture.html and click “Read More” 
under Orchy’s picture to view an  

interactive map with all his destinations 
pinned, plus additional pictures and 

descriptions for each location.

Where in the World is Orchy?

About Orchard Technical Support 
Continued from page 9.

	 We are pleased to share that the top answer from  
Quarter 4 2018 (October 1–December 31) was “Very Satisfied.” 
Even so, we will continually refer to all feedback to make 
improvements in our customer service interactions. If you 
have contact with our Technical Support team, keep your 
eyes on your email inbox for your survey link.

Orchard Sits High in KLAS Rankings
	 We appreciate you as our customer and as a part of our 
Orchard family. Our mission and our appreciation of you is 
evident in our consistently high KLAS rankings and customer 
feedback. According to the most recent KLAS data (from 
April 2019), Orchard scored a 91.0 out of 100 in the  
Relationship segment, which includes executive involvement 
and service and support. This score was above most  
competitors and the average segment score of 86.2.

Let Us Support You
	 At Orchard, we make it our mission to support your 
laboratory in a manner that exceeds your expectations 
daily. We want you to be equipped with the best tools to 
provide your patients with excellent care. Because of this 
mission, we continuously assess our ability and method of 
providing support to you, and we are consistently open 
to altering our procedures and organizational structure to 
best support your needs. 

	 Please let us know how we can support you. Sign in to 
Orchard Resource Central from our website,  
www.orchardsoft.com, or call Technical Support at  
(800) 571-5835. 
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Changes Coming to Product Documentation

You may remember from newsletter articles last year 
that we are enhancing and expanding the Product 

Center on Orchard Resource Central (ORC). We’re excited 
to update you on the progress we’ve made so far.

Updates Available Now
	 Last year, we started the process of moving the  
documentation for Orchard® Trellis™ and Orchard® Copia®  
to our centralized online help location in the Product  
Center. This year, Orchard® Sequoia™ product  
documentation is available on the Product Center. Visit 
the ORC (orc.orchardsoft.com) and click the Product 
Center icon to view additional details and video tutorials 
on using the new help system.

Updates Coming Soon
	 By the end of this year, Copia, Trellis, and Sequoia  
users will see the return of targeted help topics that  
open based on your current location in the software.  
In addition, the Product Center will house:
	 • �Orchard® Harvest™ online help, with a link  

from the software.
	 • �Orchard® Pathology online help, with a link  

from the software.
	 • �Expanded technical and user manual sections  

for Copia, Trellis, and Sequoia.
	 • ��E�nhanced navigation to more easily access  

help for specific versions of the software.

	 Beyond the changes noted above, future  
documentation updates will include additional  
embedded eLearning videos and enhanced  

search capabilities. We appreciate your patience as we 
continue to implement these major changes to how you 
access and use online help. This work is setting the stage 
for us to make some incredible enhancements to the 
product documentation, and we can’t wait to share  
everything we have planned. 

Additional Info & Feedback
	 Stay tuned to this newsletter, the ORC, and your email 
inbox for more information about the changes coming 
this year. As always, please email us at documentation@
orchardsoft.com to let us know what we can do to make 
our online product documentation even better. We greatly 
appreciate your feedback! 

Staying Up to Date: End-of-Service Reminders 

To help you stay on top of hardware and software 
updates, we offer these reminders of timelines when 

Orchard Software, Microsoft, or other companies will stop 
supporting various products. If you have questions, contact 
Orchard Technical Support at (800) 571-5835. 

	 • �Orchard Software will not release updates to the  
Interface Engine (IE) version that is compatible  
with Orchard® Harvest™ 10, Orchard® Pathology 10,  

and older versions once Harvest 12 and  
Orchard Pathology 12 are released in June 2019. Clients 
will need to update to Harvest 11, Orchard Pathology 
11, or newer to implement new instrument interfaces.

	
     • �Microsoft will no longer provide support or security 

updates for Windows 7 starting in January 2020. 
	
             • �Microsoft will discontinue support for Windows 

Server 2008 R2 editions in January 2020. 

In versions of our software that use the new help system, press Alt+? to open the help, 
then navigate to, or search for, the topic you wish to open. Future software releases  
will have enhancements that open the help for the page you are on by default.
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 2019 Orchard Software Event Calendar
Date Trade Show/Event Location

6/3-6/6 APHL Annual Meeting St. Louis, MO

6/18-6/19 Orchard Software 2019 User Group & Symposium Indianapolis, IN

8/4-8/8 AACC Annual Scientific Meeting & Clinical Lab Expo Anaheim, CA

9/21-9/25 CAP19 Orlando, FL

11/9-11/13 American College of Veterinary Pathologists Annual Meeting San Antonio, TX

Learn More About Orchard Harvest & Orchard Pathology v12


